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Hewlett-Packard Journal article December 1993 
details 89400 Series Vector Signal Analyzer

The Worlds First 
Vector Signal 
Analyzer (VSA)
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89600 VSA Software

Magnitude and 
phase time 

domain data 
analysis

Time 

High 
resolution, 
FFT-based 
spectrum 
analysis

Frequency

Demodulation 
& signal quality 
measurements

Modulation

A comprehensive toolset for demodulation & vector signal 
analysis
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Explore virtually every facet of today’s most 
complex signals
– Measure your signal: supports >75 standards and modulation types

– Leverage a first-to-market track record with support for emerging standards 
LTE-Advanced 3GPP Release 10 & WLAN 802.11ac

– Analyze proprietary signals with flexible tools for custom APSK, IQ & OFDM 

LTE-Advanced FDD/TDD
LTE FDD/TDD

W-CDMA/HSPA/HSPA+
TD-SCDMA/HSPA

GSM/EDGE/EDGE Evo
cdma2000/1xEV-DO

802.11ac WLAN
802.11n WLAN

802.11a/b/g/p/j WLAN 
802.16 WiMAX

Bluetooth
ZigBee
Wi-SUN

SOQPSK
Custom APSK

Custom IQ
RFID

Pulse analysis
FMCW radar analysis

AM/FM/PM demod
Flexible digital demod

Custom OFDM
AM/AM, AM/PM, 
gain compression

Channel quality meas

Cellular
Communications

Wireless 
Connectivity

Audio/Video 
Broadcasting

General
RF & MW

Detection, Positioning, 
Tracking & Navigation

ATSC, ATSC-M/H
DVB-C, DVB-S, 

DVB-S2/S2X
J.83A/B/C

DOCSIS, ISDB-C
DAB, DVB-T/H/SH
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Agenda
 Introduction to Vector Signal Analysis 

 Comparison between scalar SA/VSA

 Capabilities

 Block diagram          

 Fundamental signal processing

 Windowing - Resolution Bandwidth

 Time Capture

 What about real time?

 Recordings

 Vector Modulation Measurements
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Swept Spectrum Analyzer Compared to Vector Signal Analyzer

• Swept Analyzers do not measure all signal characteristics (i.e. no phase)

• Very long sweeps times required for narrow Resolution-Bandwidths 

• Provides accurate amplitude vs. frequency for time stationary signals

• Gating provides accurate amplitude .v. freq. for repetitive burst signals

• Measures RF Spectrum by sweeping a signal past a fixed I -F filter

Key Characteristics

Sweep Span

Frequency Resolution 
Bandwidth 
I-F Filter

Start Frequency Stop Frequency

Carrier
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Vector Signal Analyzers
A new Class of Analyzer

• Digitizes complete signal, magnitude and phase
• Measures RF signals IF signals or baseband signals
• Measures Time Domain, Frequency Domain and Modulation Domain
• Accurately measures time varying signals
• Record and Playback functionality
• Transforms the digitized signal data into information via Digital Signal Processing
• Measures Vector Modulated signals
• General purpose user defined Digital demodulator

tTime Domain Frequency Domain Modulation Domain
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Modern Signal Analyzer Block Diagram

VCO

RF signal

Mixer IF filter

A/D

M
em

ory

DSP
Signal Processor

Display
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16 Bit ADC

• Autoranging
• Dither on/off

ADC
FFT

Log Detectors

Digital Signal Processing

Filters

Analog IF Filter 
(Single Pole)

Attenuator
2 dB Step

Wideband PreAmp
Improve 1GHz

DANL from –153
dBm to –167 dBm

VCO

• Fast Tune
• Stepped for FFT
• Optimization for

Close in PhaseNoise
Far out Phase Noise

Sweep .v. FFT

• Fast Sweep
• Narrow BW
• High Selectivity

Digital Log Amp

• Min Linearity
Contribution

• > 100 dB
Dynamic Range

Digital IF Filter

• 160 Settings
• 1 Hz to 8 MHz RBW
• CISPR and MIL BW
• 1 Hz to 50 MHz VBW
• Min Switching

Uncertainty

Digital Detectors

•Normal
•Peak
•Minimum Peak
•Sample
•RMS
•Quasi Peak
•CISPR RMS Average

Modern Keysight Signal Analyzer Block Diagram
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Vector Signal Analyzer Block Diagram

VCO

RF signal

Mixer IF filter

A/D

M
em

ory

DSP
Signal Processor

DisplayInstrument Hardware

Instrument Hardware or PC and software
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Background information - IF  Processing  Past

Log Amp/
Detector ADC

Bits

ADC

ADC

Cos(ωt)
Sin (ωt)

Bits

Bits

Amplitude Only - Spectrum Analyzer (HP856x)

Quadrature - Network Analyzer (HP8510A,..)

Analog -- Digital

RF

RF/IF

IF2

LO1 LO2

Audio rates
at best
<12bits

Gain/Phase match errors

Detected and logged level
called video, mostly dc or slow moving

RBW

Analog
RBW filter
set here

Analog
RBW filter
set here
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Amplitude or Vector Analyzer, X-series, PSA, 89600…

Analog -- Digital

I

Q
LO

ADC

Bits
Cos(ωt)

Sin (ωt)

IF (MHz)
RF

I

Q

ASIC
Push the digitizers up the RF chain

RBW filters
done digitally

• ADC digitizes IF!
•not detected amplitude

• Fewer analog adjustments
• No temperature dependence
• Fewer components
• More flexible processing

Background information – IF Processing Today
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Vector Modulation Basics
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The Advantages of Digital 
Transmission

• One transmission system for all types of data

• Signal Processing applied to

• Error correction

• Data compression

• Encryption

• Advanced switching and multiplexing

• and many others
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Phase
0 deg

Polar Display - Magnitude and Phase Represented Together
• Magnitude is an absolute value

• Phase is relative to a reference signal
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Phase 0 deg
Phase Change

Phase
0 deg

Magnitude Change 

Both Change
0 deg

Frequency Change

0 deg

Phasors and Signal Space
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0 deg

"I"

"Q"

Q-Value

I-Value

Polar vs. "I-Q" Format
• Project signal to "I" and "Q" axes

• Polar to Rectangular Conversion
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BPSK
One Bit Per Symbol

QPSK
Two Bits Per Symbol

Vector Modulation Basics
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Digital, or Vector, modulation- Getting bits on 
to a carrier.

Example QPSK

Quadrature Phase Shift Keying

Two bits per symbol

Bit Rate = 2 x Symbol Rate 

01 00

1011

Q

I

State or Constellation diagram
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Digital, or Vector, Modulation.
States, Bit Rate & Symbol Rate

01 00

1011

Bit Rate
is the number of bits transferred per second in the 

system

Symbol Rate = Bit Rate / No. of bits per symbol,
AKA  Baud Rate

Symbol Rate
determines the minimum system bandwidth 

requirement
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Quadrature Amplitude Modulation

4 Bits per Symbol
Symbol Rate = 1/4 of Bit Rate

5 bits per Symbol
Symbol Rate = 1/5 of Bit Rate

I

Q

32 QAM16 QAM

Corner states are not used.
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Using Less Bandwidth for the Same Data
Modulation Format Number of bits

per symbol
Transmission Bandwidth

F

F/2

F/4

1

2

4

BPSK

QPSK

16QAM

Same Bits/sec
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Major Modulation Goal: Spectral Efficiency
• Theoretical Bandwidth Efficiency Limits:

Note: The figures are theoretical limits and CAN NOT be achieved in practical radios

Modulation Format Spectral Efficiency
BPSK 1 bit/second/Hz

QPSK 2 bits/second/Hz

8PSK 3 bits/second/Hz

16QAM 4 bits/second/Hz

32 QAM 5 bits/second/Hz

64 QAM 6 bits/second/Hz

128 QAM 7 bits/second/Hz

256 QAM 8 bits/second/Hz

512 QAM 9 bits/second/Hz

1024 QAM 10 bits/second/Hz

2048 QAM 11 bits/second/Hz

4096 QAM 12 bits/second/Hz 

8192 QAM 13 bits/second/Hz

16384 QAM 14 bits/second/Hz
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Transmission Bandwidth
• The spectrum of a digital signal is very wide.

• Theoretically infinite.

Roll Off rate is a function of pulse risetime, for 0 risetime pulses
the power spectrum rolls off at –20dB/decade 

f Log f

-20dB/decade
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Pulse Spectrum (baseband)       

Sinc(x) - the envelope of the 
spectral energy

+ Freq– Freq

Rate (Bit)  Symbol
Interval Sample

=
1

NRZ baseband signal

Sample Interval between symbols (bits shown here)

x
xSinxSinc )()( =

0 Hz
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The Spectrum Analyzer View
• Sinc(x) Magnitude • Sinc(x) Magnitude One Sided

• Spectrum Analyzer View

• All voltages folded over and 
doubled, except the DC. 
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The Nyquist Bandwidth 

fn= Nyquist Frequency 
= Symbol Rate/2

This condition gives zero ISI (Inter Symbol Interference)

Ideal “brick-wall” filter at the minimum bandwidth

frequency

In a radio transmitter the filtering
is done at baseband.

Envelope of digital baseband spectrum.
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Inter Symbol Interference

Zero ISI condition

0         TS

Design a filter so that at sample times the 
response of the previous pulse is zero.

Response of two successive impulses

time
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Fs : Symbol Rate
Alpha describes the "sharpness" of the filter.
Occupied bandwidth is approximately: Symbol rate X (1 + ∝)

Filter Bandwidth Parameter "∝“
Practical Filter Shapes

brickwall
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Frequency and impulse response of raised 
cosine (RC) filters 
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Modulation Quality Error Vector Magnitude (EVM)
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32QAM Which 
symbol is 

it???

Q:
What if the signal doesn’t land 
on a constellation point?

A:
Symbol error!
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Demo!
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64 QAM Constellation
Q

I

• Random Noise

• Phase Noise

• AM/AM Distortion

• AM/PM Distortion

• Delay Distortion/ISI

• Spur / Interference

• Ideal Symbol Point

Error Vector Magnitude Measurements
Constellation Errors Signatures
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Why do you need a Window ?

Original signal x(t)

Correctly 
sampled

Time record

Incorrectly sampled
Time record

Implied Periodicity

Implied Periodicity

One spectral 
line no leakage Spectrum

with leakage

f

Log 

dB

f

Log 

dB

Implied Periodicity of the Fourier Transform assumes x(t) is periodic in T.

Exact Result
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Windows Reduce Leakage

Implied
replication

Original 
signal

Sampled
record X =

Window 
Function

Modified 
Waveform

Reduced leakage 
spectrum

Window functions reduce the 
leakage errors in the 
frequency domain by 
modifying time domain 
waveform.

True
spectrum

f

Spectrum
with leakage

Log 

dB

f

Log 

dB
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Window Comparison 

37



Page

Window Characteristics Comparison
Time Domain Shape Freq. Domain Shape

WINDOW SUMMARY
Parameter Uniform Hanning Gaussian Flat Top  (Default)
Leakage Performance: Poor Relatively Good Best Good
Frequency Resolution 
main length fixed :

Poor** Relatively Good Best Better

Frequency Resolution: 
RBW fixed

Good Good Best Better**

Normalized Equivalent
Noise BW: 

1.00 Hz-sec 1.50 Hz-sec 2.215 Hz-sec 3.8194 Hz- sec 

3 dB BW 0.8844 Hz-sec 1.438 Hz-sec 2.091 Hz-sec 3.767 Hz-sec
Window Shape Factor 716:1 9.1:1 4.0:1 2.45:1
Maximum Amp. Error* 3.92 (dB) 1.42 (dB) 0.68 (dB) < 0.01 (dB)
Highest Side lobe -13 (dB) -31 (dB) -125 (dB) -95 (dB)
Side lobe Fall Off -20 dB /dec. -60 dB /dec. -20 dB /dec. -20 dB /dec.
* The maximum amplitude error occurs when a signal is halfway between frequency bins.
** Frequency resolution is best for equal amplitude signals (e.g. two closely spaced sine waves), Flat Top 
window side lobes are well below the dynamic range & noise floor of the VSA. 
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Vector Modulation Measurements
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VSA Digital Demodulation Block Diagram

Input 
signal

BW
Filter

Carrier and 
Symbol Lock Compensation

Measure 
Filter

Reference
Filter

α / BT

Reference
Generator

Symbol
Detector

Sync
Detector

Sync
Word

Sync
Position

Center
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Symbol
Timing

Recovery

Clock Adjust

Symbol Rate

Pts per Sym

Span

Pulse
Detector

Droop
Origin Offset

Result
Length

Error
Calc.

I- Q Measured

I- Q Reference

I-Q Origin Offset

Droop

I-Q Error Magnitude

I-Q Error  Phase
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Time/Spectrum

Symbols (Bits)

IQ Reference
Time/Spectrum

I-Q Measured
Time/Spectrum

Carrier
Freq Error

I- Q
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Search 
Length
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+
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Theory of Operation
Block diagram

89600 VSA softwareHardware front-end
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What about real-time?

• The real-time bandwidth is the frequency span at 
which the FFT processing time equals the time 
record length-this means all input data is included 
in the average (in other words, there is no gap 
between the end of one time record and the 
beginning of the next).
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T1

T1

gaps!

NOT Real Time

Real Time Processing
CALC3

T2

CALC1

Calculation time includes windowing, FFT, power spectrum, Linear to Log conversion, and averaging calculation plus display update!

CALC3

T2

CALC1

T3

CALC2

CALC1

T2 T3

CALC2

T1

REAL-TIME Bandwidth
• The widest bandwidth (span) that can be selected such that every sample from 

the digital filter is used in the Spectrum.  

• Real Time Bandwidth is also referred to as the "gap free" rate. 

• Double Buffering allows Calculations on previous data record while collecting 
next data record.

CALC3

T3

CALC2
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Tn -nth Time Record
CALCn -Processing of nth Time RecordT1

 More averages/unit time
 Quicker variance reduction
 Recovers data lost due to window function

0% Overlap

50% Overlap

Processor idle

T2

Window Function

T1

CALC1 CALC2 CALC3 CALC4 CALC5 CALC6

T2

CALC1

T3

CALC2 CALC3

T3

T4
T5

T6

Overlap Processing
• When in real time operation the analyzer can do additional signal processing.
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Recording signals

Why record signals

•No gaps! Continuous time record at full bandwidth. 
•Long records. Up to 512 mega samples (Keysight XSA Family). 
•Powerful post processing. More control over the analysis. 
•Analyze in the frequency, time, analog or digital demodulation domains. 
•Slow playback with overlap processing. 
•Porting of simulations back to design software. 
•Archiving. Save signal records for future analysis. 
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Gap free analysis
• Overlap Processing

• Recording playback requires that the recording buffer be broken into time records 
for processing and display. Shown in blue below, is the normal way to do that. 
This method results in the fastest playback speed.

• Overlap processing advances through the recording buffer by "sliding" the time 
record window through the buffer. You controls the rate at which data is replayed 
(0% to 99.99%). The result is a slower playback. Data lost by the FFT windowing 
process is now analyzed as well. 

•
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Recording signals
To record a signal

1. Acquire the signal in the normal 
fashion. See Acquiring a signal.
Be sure that the Span chosen will 
contain the signal characteristics 
of interest.
Choose the most sensitive Range
without the possibility of overload. 

2. Use triggering to ensure when the 
recording will start.
Consider pre-triggering (negative 
trigger delay) to start recording 
before the event of interest 
occurs. 

3. Set up recording length. Click 
Input > Recording > Length.
This can be specified in points, 
records, or seconds. 

4. Click Control > Record or click the   
record button. 

5. When a qualified trigger occurs 
the recording will begin.
Recording is immediate when no 
triggering is specified. 
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Playback recordings
• Recording playback can be started by clicking the Play key or Control > Restart.

• Or

• Click Window > Player.

• The player lets you:

• Start and pause the playback 

• Drag the bar to any position in the record 

• Back up and rewind 

• Loop the recording 

• Set start and stop times 

• Re-record 
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Playback Control

– The Start Time for Analysis can be set  by typing in a Time in the Player dialog box or click and dragging 
the slide bar of the time Record buffer data to be used for a measurement.

Anti-alias 
filter (analog) ADC Anti-alias

filter (digital)

RAM

Post
Processing

Time Recording RAM 
Buffer

Start
Set Start at 

Current 
Position

Set End at 
Current 
Position

Loop Control

To view all or a large portion of the Recording Buffer, increase the number of Frequency Points.. Expanded view of Time Gated Signal
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Keysight 89601B Player Control Window 
Detail

Control Icons and Indicators on Player Window Interface

Start

Set Start time 
to Current 
Position

Set Stop Time 
to Current 
Position

Loop ControlPause

Re-Record

Full Time

Graphical Time 
Advance Indication
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Summary Recording Post-processing 
Changes in Measurement Parameters

• After data has been Recorded, many measurement parameters can be 
changed, for each pass through the Recording. 

Changes can be made to:
• Center Frequency & Span
• Resolution BandWidth
• Number of Frequency Points
• Window - ResBW
• Time length
• Gate Delay & length
• Average types, overlap processing
• Sweep mode, Single or Continuous
• Demodulation type

• Analog - Demodulation
• Digital - Demodulation
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Keysight Vector Signal Analyzers
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VCO

Signal
input

Mixer IF filter

A/D

M
em

ory

DSP
Signal Processor

Display
Instrument Hardware or PC and software

Vector Signal Analysis Block Diagram
Analog RF

Signal Capture Instrument Hardware
Spectrum Analyzer
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Signal
input

A/D

M
em

ory

DSP
Signal Processor

Display
Signal Capture Instrument Hardware

Oscilloscope

Instrument Hardware or PC and software

Vector Signal Analysis Block Diagram
Analog IF or IQ baseband
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Signal
input

M
em

ory

DSP
Signal Processor

Display
Signal Capture Instrument Hardware

Logic Analyzer

Instrument Hardware or PC and software

Vector Signal Analysis Block Diagram
Digital IF or IQ baseband
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89601B
VSA Software

Keysight Vector Signal Analyzers

N4010A Bluetooth and WLAN Tester

M9391 PXI VSA

Keysight ADS or SystemVue

16900 Series Logic Analyzer

Infiniium Series OscilloscopesX-Series Signal Analyzers

M9703 Series High Speed 
digitizer
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First-to-Market in Wireless
– IEEE 802.11ac WLAN 

• All signal BWs: 20, 40, 80, 80+80, 160 MHz

• All modulation formats: BPSK to 256QAM

• Up to 8x8 MIMO & multi-user MIMO

– LTE-Advanced 3GPP Release 10

• Carrier aggregation
- Contiguous and non-contiguous spectrum 

allocations
- Uplink & downlink signals
- Analyze up to 5 CCs simultaneously

• Enhanced uplink
- Clustered SC-FDMA
- Simultaneous control and data

channel support
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FMCW Radar AnalysisPulse Analysis Channel Quality 
Measurements– Linear FM Chirp 

Analysis

– Automotive Radar

– A/D Radar and EW

– General Radar
– Multi-tone group delay 

for satellite systems

Supports new UXA signal analyzer, 
up to 1 GHz bandwidth

Robust Analysis in A/D, Automotive & Satellite

58



Page

Industry-Standard Tools for Proprietary Signals

– Custom APSK
• APSK constellations, staggered

• High-order PSK (e.g. 16PSK, 32PSK)

• Amplitude Shift Keying (on-off keying)

– Custom IQ
• IQ constellation editor for custom, 

proprietary, non-standard, unique, 
asymmetric signals 

• Longer symbol length with 
synchronization robustness  

– Custom OFDM
• Demodulation of custom, proprietary 

OFDM-based signals

• Support for multiple streams and users
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Apply Vector Signal Analysis Across the Lifecycle
Produce consistent, comparable results from simulation to production

Simulation

• ADS
• SystemVue

Baseband 
Design

• Logic 
analyzer

• Oscilloscope
• Modular 
digitizer

IF, RF, uW  
Design

• Signal 
analyzers –
benchtop & 
modular

• Oscilloscope

System 
Verification

• Signal 
analyzers –
benchtop & 
modular

Quality 
Assurance

• Signal 
analyzers –
benchtop & 
modular

Production

• Signal 
analyzers –
benchtop and 
modular

Compatible file 
formats

Supports >45 Keysight 
measurement platforms
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Thoroughly Characterize Designs

– Measure device distortion with the signals it will see during real-
world operation

• Wide bandwidth, high PAPR signals, like OFDM, stress devices 
much more than CW tones. 

– Measurement results include

• AM/AM

• AM/PM 

• Gain Compression

• Differential (∆) EVM

• ∆ EVM vs. Time

• Propagation delay

• Best fit curve

Complex stimulus-response measurements
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Verify Signal Problems Quickly
Powerful display increases clarity
– Isolate unexpected 

behavior with unlimited 
markers and marker 
coupling between traces

– Intuitively analyze 
today’s most complex 
signals with color-coded 
results by channel and 
user
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Analyze & Display Multiple Signals—Simultaneously

– Perform multiple measurements at once; 
display all results together

– Control multiple instruments to obtain wider 
frequency coverage

– Use multi-measurements to simultaneously:
• Demodulate different signal types

• Analyze signals at varying frequencies

• Check for interactions between signals 

• Measure signals at different physical test 
points

• Analyze both uplink & downlink signals 

• Use different analysis parameters 
(span, demod properties, etc.)

Multi-measurements

EVM 
Span: 600 kHz

ACPR
Span: 2 MHz
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Multi-Measurements
Signal acquisition styles

Independent, multi-box:
Synchronized measurements at 
same/different freqs, spans, formats, 
etc. using multiple HW front ends and 
triggering.

Independent, same-box:  Non-
simultaneous measurements at 
various freq’s, spans, formats, etc. 
using a single HW front end. 

Fast switching
F1

F3

F4

F2

Unlimited BW

Shared:  Acquire once, then perform 
multiple, truly simultaneous meas. 
within the max span width. F1 F2 F3 F4

Simultaneous
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Pinpoint the Answers to Signal Problems 

– Easily record signals with familiar controls

– Catch elusive signals with flexible 
triggering

• Trigger acquisition based on 
magnitude, frequency or external

– Play back gap-free recorded signals for 
detailed analysis

• Modify parameters like overlap 
processing during playback 

• Utilize persistence displays to analyze 
behavior over time

• Download recorded signal files into 
Keysight vector signal generator for 
playback

Advanced troubleshooting tools for capture & playback
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View & Organize Your Results

– View unlimited traces with unlimited markers

– Optimize trace arrangement to see signal patterns & interactions

– Adjust trace shape to extend event observation time or increase viewable 

Flexible GUI enables greater insight

Trace 
data

Hotspot

Trace 
format
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89600 VSA Software

– Measure signals in cellular, 
wireless connectivity, aerospace, 
defense, and general-purpose 
applications

– Multiple simultaneous views

– Advanced troubleshooting tools

– Works across your design process: 
supports >45 measurement 
platforms

See through the complexity

Subscription service keeps 
you up-to-date
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89600 VSA Ordering Information
89601B (transportable), 89601BN (floating)
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Try 89600 VSA Software Today

– Play recorded demo signals

• >110 signals available

• File > Recall > Recall Demo

– Learn more with Dynamic Help

• Click any feature to view text

• Help > Dynamic help

Free 30-day trial

www.keysight.com/find/vsa_trial
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Additional Resources

– Web Page: www.keysight.com/find/89601B

– Literature

• Vector Signal Analysis Basics, application note, literature number 
5990-7451EN

• Brochure, literature number 5990-6553EN

• Configuration guide, literature number 5990-6386EN
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Thank You
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